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Disclaimer
Thunderhead Engineering makes no warranty, expressed or implied, to users of PetraSim, and accepts
no responsibility for its use. Users of PetraSim assume sole responsibility under Federal law for
determining the appropriateness of its use in any particular application; for any conclusions drawn from
the results of its use; and for any actions taken or not taken as a result of analyses performed using
these tools.
Users are warned that PetraSim is intended for use only by those competent in the field of multi-phase,
multi-component fluid flow in porous and fractured media. PetraSim is intended only to supplement the
informed judgment of the qualified user. The software package is a computer model that may or may
not have predictive capability when applied to a specific set of factual circumstances. Lack of accurate
predictions by the model could lead to erroneous conclusions. All results should be evaluated by an
informed user.
Throughout this document, the mention of computer hardware or commercial software does not
constitute endorsement by Thunderhead Engineering, nor does it indicate that the products are
necessarily those best suited for the intended purpose.
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One Dimensional Gas Diffusion of an Organic Chemical
(T2VOC)
Description
This example demonstrates one dimensional gas diffusion of an organic chemical with phase partitioning
- as described in the T2VOC User's Guide (1).
A horizontal column has an initial temperature of 10° C and an initial pressure of 101325 Pa. The left cell
has a fixed thermodynamic state and acts as a source of chlorobenzene. The geometry of the problem is
shown in Figure 1.

Figure 1: Example Problem Overview
We will use a mesh with 150 cells in the horizontal direction.

Create a T2VOC Model
We will first create a new model using the T2VOC EOS.
From the File menu, select New… to open the New Model dialog.
1. For the Simulator Mode, choose TOUGH2.
2. For the Equation of State (EOS), choose T2VOC.
3. For the Model Bounds, enter the values from Table 1.
Table 1: Model boundary dimensions
Axis
X
Y
Z

Min (m)
0.0
0.0
0.0

Max (m)
15.0
1.0
1.0

Click OK to close the New Model dialog and create the model.
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You can rotate, pan, and zoom the model using the mouse and Shift and Alt keys. The resulting
boundary is shown in Figure 2. PetraSim will automatically add labels for the min point and max point of
the boundary.

Figure 2: The Model Boundary

Specify the Solution Mesh
The solution mesh must be specified in two steps. First the Z divisions must be specified per layer. Then
the mesh can be created using the Create Mesh dialog.
Specify Z Divisions
We must first specify one Z division for the default layer. To do so, we will open the Edit Layers dialog.
On the Model menu, select Edit Layers….
1.
2.
3.
4.

In the layers list in the left-hand pane, select the Default layer.
In the right-hand pane, select Regular for Dz.
In the Cells box, type 1.
In the Factor box, type 1.0.

Click OK to apply the changes and close the Edit Layers dialog.
Create the Mesh
We will now create the radial solution mesh using the Create Mesh dialog. To open the dialog, on the
Model menu, select Create Mesh….
1.
2.
3.
4.

For the Mesh Type, select Regular.
For the Divisions, select Regular.
In the X Cells box, type 150.
In the Y Cells box, type 1.
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5. For both X and Y Factors, type 1.0.
Click OK to create the mesh.

Global Properties
Global properties are those properties that apply to the entire model. In this example we will set the
simulation name and configure the simulation VOC. To edit global properties, you can use the Global
Properties dialog.
On the Properties menu, select Global Properties….

Simulation Name
1. In the Global Properties dialog, select the Analysis tab.
2. In the Name box, type T2VOC Problem 1.

EOS Data
The EOS (Equation of State) tab displays options for the T2VOC simulator. In this example, we will
perform an isothermal (no heat flow) analysis. We will also specify a variant of chlorobenzene as the
simulation VOC and specify the Air-Vapor diffusion constant.
In the Global Properties dialog, select the EOS tab.
By default, the simulator will run in isothermal mode. Nothing needs to be changed.
To specify the VOC, you will need to create a variant of chlorobenzene using the Edit VOC Data dialog.
1.
2.
3.
4.
5.
6.

Click Edit VOC Data….
Click New.
In the Name box, type Chlorobenzene Ex 1.
In the Based On list, select Chlorobenzene (STD).
Click OK. This creates a new VOC.
Update the values for CHEMP.4, CHEMP.6, and CHEMP.7 according to the values shown in Table
2, Table 0.3, and Table 4.
7. Click OK and ensure that the selected Simulation VOC is Chlorobenzene Ex 1.
8. This simulation will use gas diffusion. You can enable gas diffusion by setting the Air-Vapor
Diffusion to a non-zero value. In the Air-Vapor Diffusion box, type 2.13e-5.
9. Click OK to close the Global Properties dialog.
Table 2: Chlorobenzene Ex 1 (CHEMP.4)
Field
Reference Density for NAPL
Reference Temperature for NAPL
Reference Binary Diffusivity of VOC in Air
Reference Temperature for Gas Diffusivity
Chemical Diffusivity Exponent

Value
1106.0
293
8.0e-6
283.15
1.0
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Table 0.3: Chlorobenzene Ex 1 (CHEMP.6)
Field
SOLA
SOLB
SOLC
SOLD

Value
7.99e-5
0.0
0.0
0.0

Table 4: Chlorobenzene Ex 1 (CHEMP.7)
Field
Chemical Organic Carbon Partition Coef
Default Fraction of Organic Carbon in Soil
VOC Biodegradation Decay Constant

Value
0.15
0.005
0.0

Figure 3: T2VOC Simulation Parameters

Material Properties
To specify the material properties, you can use the Material Data dialog.
1. On the Properties menu, click Edit Materials….
2. In the Name box, type DIRT1.
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3.
4.
5.
6.
7.
8.

In the Density box, type 2650.0.
In the Porosity box, type 0.4.
In all three Permeability boxes, type 1e-14.
In the Wet Heat Conductivity box, type 3.1.
In the Specific Heat box, type 1000.0.
Click Apply to save the changes.

We still need to specify the relative permeability function and fraction of organic carbon for this
material. These options can be found in the Advanced Material Data dialog. To open this dialog, click
the Additional Material Data… button.
To specify the relative permeability function:
1.
2.
3.
4.
5.
6.

Select the Relative Perm tab.
In the Relative Permeability list, select Stone’s 3-Phase.
In the Swr box, type 0.4.
In the Snr box, type 0.1.
In the Sgr box, type 1.0e-3.
In the n box, type 1.0.

The default capillary pressure (none) is correct for this example.
To specify the fraction of organic carbon:
1. Select the Misc tab.
2. In the Fraction of Organic Carbon box, type 0.005.
Click OK to exit the Additional Material Data dialog.
Click OK again to save your settings and exit the Material Data dialog.

Initial Conditions
You can control the initial state of the primary variables using initial conditions. Primary variable
selection will depend on several factors including EOS selection, simulator mode, and the initial state of
the simulation. You can edit initial conditions globally and on a cell-by-cell basis.
To edit global initial conditions: on the Properties menu, select Initial Conditions….
For this example, we will initialize all cells to a two-phase water and air state. There is no initial
chlorobenzene saturation. To set the initial conditions:
1.
2.
3.
4.
5.

Select the Two-Phase Water/Air state option.
In the Pressure box, type 101325.0.
In the Temperature box, type 10.0.
In the Water Saturation box, type 0.25.
In the VOC Mole Fraction in Air box, type 0.0.
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6. Click OK.

Boundary Conditions
We will inject chlorobenzene into the model using a cell-specific initial condition. Then we will force the
state of that cell to remain constant. To edit individual cells, you can use the 3D View.
Every cell in the model has a unique ID number. You can find and select cells based on their ID number
using the Find field in the upper-right corner of the 3D View. In this example, cell 1 will be the
chlorobenzene source. To find and select cell 1:
1. In the Find box, type 1.
2. Press ENTER. The cell should be selected and shown in the center of the 3D View.

Figure 4: Finding a Cell in the 3D View
You can now edit the properties of cell 1. Ensure cell 1 is selected. On the Edit menu, select
Properties….
To force the state of this cell to remain constant throughout the simulation, you can adjust its type.
Select the Properties tab. Then, in the Type list, select Fixed State.
Now you can give the cell a custom initial condition that will remain constant throughout the simulation.
Select the Initial Conditions tab. To enter the custom initial conditions:
1.
2.
3.
4.

Select Specify Initial Conditions by Cell.
Select the Three-Phase Water/Air/NAPL state.
In the Gas Saturation box, type 0.75.
In the Water Saturation box, type 0.2.
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Notice that we did not explicitly specify a NAPL saturation. With the gas saturation at 0.75 and the
water saturation at 0.2 the NAPL saturation will be 0.05. T2VOC will perform this calculation during the
simulation.
Click OK to close the Edit Cell Data dialog.

Solution Controls
We will now adjust the time step T2VOC will use while executing the simulation. Options relating the
time step and other simulation options can be found in the Solution Controls dialog.
To open the Solution Controls dialog: on the Analysis menu, click Solution Controls….
For this example, we will adjust the end time, increase the maximum number of time steps, and limit
the size of the maximum time step.
1.
2.
3.
4.

In the End Time box, type 1 yr.
In the Max Num Time Steps box, type 350.
In the Max Time Step list, select User Defined.
In the Max Time Step box, type 5 days.

Click OK to exit the Solution Controls dialog.

Output Controls
By default, T2VOC will print output every 100 time steps. We can increase the resolution of the output
with the Output Controls dialog.
1. On the Analysis menu, click Output Controls….
2. In the Print and Plot Every # Steps box, type 5.
3. Click OK to exit the Output Controls dialog.

Save and Run
The input is complete and you can now run the simulation. Bear in mind that T2VOC generates many
output files and they will overwrite the output from any previous simulations in a directory. If you
haven't already, you may want to save your model in a directory specifically intended for the simulation
results. For example:
1. On the File menu, click Save.
2. Create a new folder named t2voc_problem_1 and in the File Name box, type t2voc_prob1.sim.
3. Click Save.
To run the simulation, on the Analysis menu, click Run TOUGH2.
During the solution, a graph will display the time step size. In this case, the time steps increase until
they remain constant at the specified maximum.
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Figure 5: Running T2VOC

View 3D Results
To view the 3D results for a simulation
1. On the Results menu, click 3D Results. The data for the current simulation will be automatically
loaded and displayed.
To view the VOC concentration for the last time step.
1. In the Time(s) list, select the last entry (3.156E07).
2. In the Scalar list, select CVOCGAS.
3. Click to clear the Show Isosurfaces checkbox.
To add a slice plane on which contours will be displayed, click Slice Planes…. For this example we will
show one slice plane. To configure the slice plane
1.
2.
3.
4.

In the Axis list, select Z.
In the Coord box, type 0.5.
Ensure that the Scalar check box is checked.
Click Close.

Your results should now look similar to the screenshot in Figure 6. You can now see the gas-phase VOC
concentration emanating from the left side of the model.

8

Figure 6: T2VOC 3D Results
Close the 3D Results window.
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